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About the Product

Display modules with an LED (light-emitting diode) backlight are used by the
PanelView™ Plus 6 and PanelView Plus 700 to 1500 platforms. Earlier displays have a CCFL
(cold-cathode fluorescent lamp) backlight.

IMPORTANT [fyou replace a 12-inch or 15-inch CCFL display with an LED display, you must upgrade the terminal firmware
for the device to operate correctly.

A firmware upgrade is not required for configured terminals that include a display module and logic module.
The upgrade is required only when ordering an LED display module to replace an existing CCFL display module.

Each display module has a catalog number and a series letter. The series letter differentiates an
LED-backlit display from a CCFL-backlit display. You can find the series letter on the back of
the display. Refer to the table to identify the type of display you have.

Display Size | Cat. Nos. LED Series Displays CCFL Series Displays

15-inch 2711P-RDK15C, 2711P-RDT15C, Series C Series B or earlier
2711P-RDB15C, 2711P-RDT15AG

12-inch 2711P-RDK12C, 2711P-RDK12CK, | SeriesD Series C or earlier
2711P-RDT12C,2711P-RDT12CK
2711P-RDT12AG,

2711P-RDB12(,2711P-RDB12CK
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2 LED Display Modules

Important User Information

Solid-state equipment has operational characteristics differing from those of electromechanical equipment. Safety Guidelines for the
Application, Installation and Maintenance of Solid State Controls (publication SGI-1.1 available from your local Rockwell Automation®
sales office or online at http://www.rockwellautomation.com/literature/) describes some important differences between solid-state
equipment and hard-wired electromechanical devices. Because of this difference, and also because of the wide variety of uses for
solid-state equipment, all persons responsible for applying this equipment must satisfy themselves that each intended application of
this equipment is acceptable.

In no event will Rockwell Automation, Inc. be responsible or liable for indirect or consequential damages resulting from the use or
application of this equipment.

The examples and diagrams in this manual are included solely for illustrative purposes. Because of the many variables and
requirements associated with any particular installation, Rockwell Automation, Inc. cannot assume responsibility or liability for actual
use based on the examples and diagrams.

No patent liability is assumed by Rockwell Automation, Inc. with respect to use of information, circuits, equipment, or software
described in this manual.

Reproduction of the contents of this manual, in whole or in part, without written permission of Rockwell Automation, Inc., is
prohibited.

Throughout this manual, when necessary, we use notes to make you aware of safety considerations.

WARNING: Identifies information about practices or circumstances that can cause an explosion in a hazardous
environment, which may lead to personal injury or death, property damage, or economic loss.

ATTENTION: Identifies information about practices or circumstances that can lead to personal injury or death,
property damage, or economic loss. Attentions help you identify a hazard, avoid a hazard and recognize the
consequences.

SHOCK HAZARD: Labels may be on or inside the equipment, for example, a drive or motor, to alert people that
dangerous voltage may be present.

BURN HAZARD: Labels may be on or inside the equipment, for example, a drive or motor, to alert people that
surfaces may reach dangerous temperatures.

> BB

IMPORTANT  Identifies information that is critical for successful application and understanding of the product.
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Replace Display Module

To replace a display module, refer to the appropriate manual under Additional Resources.

IMPORTANT Before mounting the LED series display module, make sure the firmware installed in the logic module is at the

firmware revision listed in the table under Upgrade Firmware.

You must use CCFL series display module to upgrade the firmware; the display must be for 700 to 1500
platforms.

If no other display is available, the complete terminal must be returned to your local Allen-Bradley distributor
for exchange or repair.

Upgrade Firmware

Follow these steps to locate the firmware update for your terminal.

1.

2
3.
4

Go to http://www.rockwellautomation.com/support/pcdc.page.

Click the Get Downloads tab.
Click Find Product Downloads.

From the All Families pull-down menu, choose PanelView Plus 6 700 - 1500 or
PanelView Plus 700 - 1500.

Click the family selection, then choose a firmware revision from the list.

The table shows the firmware revision required for your terminal.

For This PanelView Plus Family Choose This Firmware Revision

PanelView Plus/PanelView Plus CE700to 1500 | 5.10.11 or later

PanelView Plus 6 700 to 1500 7.00.20130619 or later

Click Find Downloads at the bottom of the Selections tab.
Under Downloads, click the show downloads é icon to access the firmware.

Download the upgrade file (.exe) to a temporary folder on the same drive as FactoryTalk®
View Machine Edition (ME) software.

Run the upgrade file (.exe) installation procedure:
e The FUW is installed in the FactoryTalk View ME folder.
o The firmware upgrade package (.fup) file is installed into the folder specified during

the installation procedure.

You are now ready to run the FUW to upgrade the terminal firmware from a storage device or by

using a network connection.
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4 LED Display Modules

Firmware Upgrade Wizard

The Firmware Upgrade Wizard (FUW) is used to upgrade the terminal firmware. Two methods
are provided for upgrading the firmware:

Create a firmware upgrade card with the contents of the FUP file that you can then load
in the terminal to upgrade the firmware.

The firmware upgrade card can be a USB flash drive, CompactFlash (CF) card, or an SD
card, catalog number 1784-SDx.

Upgrade firmware in a terminal connected to a computer over a direct network
connection. The network connection requires a computer with RSLinx" Enterprise
software installed.

RSLinx Enterprise software is required so you can choose the terminal to upgrade.

IMPORTANT  Use the latest version of RSLinx Enterprise software, which is available at
https://rockwellautomation.custhelp.com/app/answers/detail/a_id/49190.

You can run the FUW from within FactoryTalk View Studio software or from the Programs

menu on your computcr:

In FactoryTalk View Studio software, from the Tools menu, choose Firmware Upgrade
Wizard.

Choose Start>Programs>Rockwell Software>FactoryIalk View>Tools>ME Firmware
Upgrade Wizard.

Upgrading Terminal Firmware from a Storage Device

Upgrading firmware from a storage device is a two-step process. First, you create a firmware

upgrade card with the required firmware files. Secondly, you load the card in the target terminal

to upgrade the firmware.

The firmware upgrade card can be a USB flash drive, CF card, or an SD card.

(reate a Firmware Upgrade Card

Follow these steps to copy firmware files to a USB flash drive, CF card, or SD card.

1.

Insert cither a USB flash drive, CF card, or an SD card into the appropriate slot on your
computer.

Run the Firmware Upgrade Wizard:

a. InFactoryTalk View Studio software, from the Tools menu, choose Firmware
Upgrade Wizard.

b. Choose Start>Programs>Rockwell Software>FactoryTalk View>Tools>ME
Firmware Upgrade Wizard.
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3. Follow these steps from the initial FUW dialog box.
a. Click Create firmware upgrade card (A).

b. Choose the location of the firmware card by browsing to the root directory of the
storage card loaded in your computer (for example, H:\ or B).

The firmware files are copied to this location. You can also specify a folder on the

hard drive.

c. From the Existing terminal type pull-down menu, choose a version v6.00-v7.00
PanelView Plus 6 terminal.

The example shows the firmware upgrade is for a 700 - 1500 PanelView Plus 6
terminal (C).

d. Click Next (D).
e

Select the type of firmware upgrade to perfarm:
" Upgrade fimsare on teminal

& Create firmware upgrade card o

Firmware card location:

O =]

Existing terminal type:

700 - 1500 [ME vE.0 Mate: Panelview Plus CE FUP should be
= used for Versavfiew CE teminals

< Back l Nest > I Cancel Help
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6 LED Display Modules

4. Follow these steps from this dialog box.

a.

Browse to the location of the firmware source files on your computer, where the FUP
was installed (E).

From the Upgrade firmware version pull-down menu, choose the firmware revision

for the upgrade (F).
Click Next (G).

It can take several seconds for the next dialog box to appear while the FUP is being

retrieved.

€ Firmware Upgrade Wizard ] =10 x]

Terminal type: Paneliew Plus B F00- 1500 [ME +6.00 - +7.00]

Firmwars source folder:
GIC.\PrUgram FilesRockwell 5oftware'FiSWiew Enterprize\FUPs\

Upgrade firrmware version;

[Major . Minar . Release Date |

¢ Back I Mext > I Cancel | Help |

5. Follow these steps from this dialog box.

a.

Optionally choose the KEPServer drivers you want included in the firmware (H).

b. Click Next (I).

Kepware drivers are already installed on the PanelView Plus 6 terminals.

€2 Firmware Upgrade Wizard

o[X)

Select the KEPServer drivers to be included in the fimware:

~

[ aller-Bradley Bullstin 1602
[ aller-Bradley Bulletin 900 G
D AutorationDirect DirectMet

[ automationDirect EBC

[ automationDirect ECOM
Oeacnetjr

[ GE Ethernet

[ sE Ethernet Global Data

O Mitsubishi Ethernet

O Mitsubishi Fx

O Mitsubishi F et

O mitsubishi Serial v

< Back | Mest > | Cancel Help
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LED Display Modules 7

The final dialog box summarizes your choices for creating the firmware upgrade card.
6. Click Finish to update the firmware in the terminal.

€ Firmware Upgrade Wizard s o ] £ |

Press Finigh to create the fimware upgrade card.

Upgrade type: Firmwsare upagrade card

Terminal ype; Fanehfizw Pluz B T00- 1500 [ME «6.00 - +7.00)

Uparade firmware wersion: F.O00-20121214 [Major . Minor . Release Date |
Firmware card location: H:4

WigwPoint: Yes

KEPServer drivers: <Mone:

< Back l Finish I Cancel | Help |

A progress bar automatically updates as files are copied to the USB flash drive, CF card,
or SD card.

7. Click OK when the firmware upgrade completes successfully.
5

.
\!J) The firmware upgrade card was created successfully,

TIP If the firmware files were copied to the hard drive, copy the files to the root directory of the USB flash
drive, CF card, or SD card.
Remove the USB flash drive, CF card, or SD card from your computer.

9. Proceed to the next section to use this firmware upgrade card to upgrade the terminal
firmware.

Upgrade Terminal Firmware by Using Firmware Upgrade Card

Follows these steps to transfer firmware files from the USB flash drive, CF card, or SD card to the
terminal. This is the firmware upgrade card created in the previous section.

IMPORTANT o Do not remove or accidently disconnect the USB flash drive, CF card, or SD card while a
firmware upgrade is in process. This could corrupt the firmware and make the terminal
unstable.

o Do not power off the terminal during a firmware upgrade.
o USB hubs can produce unexpected behavior and are not recommended.
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8 LED Display Modules

1. Insert the USB flash drive, CF card, or SD card into the appropriate slot on your
terminal.

The firmware upgrade automatically starts and displays this dialog box.

2. Press Upgrade or [F7] on the terminal to start the firmware upgrade.

Firmware Upgrade Card i x|

Firrnware version (Major. Minor. Patch. Build)
Terminal 06.00.00 06.00.00
Upgrade Card 07.00.00

The terminal is about to be upgraded with new firmware
FactoryTalk View ME Station and any running applications will
be terminated

After updating files, the terminal will be restarted to complete
the upgrade

Press the Upgrade button to continue. Otherwise, press the
Exit button and remove the firnmvare upgrace card.

Upgrade Exit
[F7 [F8]

The terminal restarts and displays a progress bar during the upgrade.
When the upgrade is complete, the terminal restarts, executing the new firmware.

3. Remove the USB flash drive, CF card, or SD card from the terminal.

Upgrade Terminal Firmware over the Network

You can upgrade firmware in a terminal connected to a computer over a direct network
connection. The network connection requires a computer running the FUW and RSLinx

Enterprise software.

RSLinx Enterprise software is required so you can choose the terminal on the network.

IMPORTANT  Use the latest version of RSLinx Enterprise software, which is available at
https://rockwellautomation.custhelp.com/app/answers/detail/a_id/49190.

Follow these steps to copy firmware files to the terminal over a network by using RSLinx
Enterprise software and Ethernet communication.

1. Runthe FUW:

a. In FactoryTalk View Studio software, from the Tools menu, choose Firmware
Upgrade Wizard.

b. Choose Start>Programs>Rockwell Software>FactoryTalk View>Tools>ME
Firmware Upgrade Wizard.
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2. Click Upgrade firmware on terminal (A) and click Next (B).

€2 Firmware Upgrade Wizard

Select the type of firmware upgrade to perform:

of‘“ Upgrade firmware on terminal

" Creats firmware upgrade card

Cancel Help

3. Click Yes to continue.

Firmware Upgrade

All MER files should be backed up and removed from the Panelview Plus, Paneltfiew Plus CE, or Panelview Plus Compact terminal before performing a

\?'} Firmware Upgrade.

Do you wish o eontinue?

It is not necessary to back up files on PanelView Plus 6 terminals.
4. Click Network Connection (using RSLinx Enterprise) (C).

This is the only valid selection for PanelView Plus 6 terminals.

€3 Firmware Upsrade Wizard

Select the type of connection ta the terminal:

[GF MNetwork connection (using RSLinx Enterprisef
[Only connection type available for use with FactayT alk View ME Station wB.00 or later terminals. ]

" Ethermet connection [using Panelfiew File Transfer Ltiliy]

" Serial connection
[using Panel¥iew File Transfer Utlity and BAS connection]

< Back | Hext > | Cancel Help

5. Click Next (D).
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10 LED Display Modules

6. Navigate to and select the terminal to receive the firmware update.

IMPORTANT The highlighted selection in the figure below is only for illustration purposes. Your model can be
ifferent.

€2 Firmware Upgrade Wizard g ] |

Select the teminal:

o 10,108, 18.2, 2080-LCS0-24Q4B, MicroBs0 2 j
- m 10,102.18.13, Panelview Plus_6 700, Paneliew Plus_g& 700

+ 4 10,108, 18,62, 2080-LC50-240WB, Microg50 9

+ 4 10,108, 18,109, 2080-LCS0-240VB, Microgso 5

‘|--ﬂ 10.108.18.148, 1756-ENBT/A, 1756-ENBT/A 7

J--ﬂ 10.108.18.150, 1756-ENBT/A, 1756-ENBT/A 6
3 =
)
)
3}
+

ﬂ 10.108.18.252, 1756-ENBT/A, 1756-ENRT/A
ﬂ 10.108.18.253, 1756-ENBT/A, 1756-ENBT/A 3
-4 10.108.19.1, 2080-LCS0-48088, Micro850 &
-4l 10.108.19.54, 2080-LCS0-480QBE, Microgs0 3
]--ﬂ 10.108.19.87, 1756-ENBT /A, 17S6-ENBT /A 4
[+ 10.108.19.101, Panelview Plus_& Cormpact 600, Panelview Plus_6 600 LI

Made: Online Nat Browsing

< Back I Mext > I Cancel Help
7. With the terminal selection highlighted, click Next.

8. Follow these steps from this dialog box.

a. Browse to the location of the firmware source files on your computer, where the FUP
was installed.

The default location is shown (E).
b. Choose the version of the upgrade firmware from the pull-down menu (F).
c. Click Next (G).

It can take several seconds for the next dialog box to appear while the FUP is being

retrieved.

ks Firmware Upgrade Wizard I =1

Selected terminal
Terminal type: Panelfiew Plus B 1250 [ME w6.00 - +7.00)
Firmnware version: FlaM]00.1100.11 [ Majar . Minor . Patch . Build |

Firmware source folder:
o] C:\Program Files\Rockwell Software \RSYiew EnterprisebFLUPzh I

Uparade fimware version:

[ Major . Minar . Release Date |

< Back I Mext » I Cancel Help
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LED Display Modules 11

9. From this dialog box, optionally choose the KEPServer drivers you want included in the

firmware, then click Next.

Kepware drivers are already installed on the PanelView Plus 6 terminals.

The final dialog box summarizes your choices for upgrading the terminal firmware.

€2 Firmware Upgrade Wizard

Select the KEPServer divers to be included in the fimuare:

O allen-Bradley Bulletin 1609 fad
[ allen-Bradiey Bullstin 200

D AutomationDirect Directhet

[ automationbivect EBC

[ #utomationDirect ECOM

Oeacretiip

[ s Ethernet

[ 5E Ethernet Global Data

[ mitsubishi Ethernet

[ mitsubishi F:

[ ticsubishi F: et

[ miksubishi Serial -

< Back I Next » Cancel | Help |

10. Click Finish to update the firmware in the terminal.

€ Firmware Upgrade Wizard = =] ]

Press Finish to upgrade the firmware on the terminal.

Upgrade type: Teminal firmware upgrade
Teminal tppe: Panelview Flus B 1250 [ME vE.00 - +7.00)
Current firmware version FIAM100.1100.11 [Maijor . Minor . Patch . Build ]

Upagrade firmware version: 7.00-20121214
YiewPoint Yes

KEPServer drivers: <Manes

< Back I Finizh I Cancel Help

11. Click Yes to continue with the update.

A progress bar updates as firmware files are copied to the terminal.

Firmware Upgrade

The terminal is about ta be upgraded with new Firmware.

FactoryTalk Wiew ME Station and any running applications will be terminated.
After downloading Files, the terminal will be restarted o complete the upgrade.

Do wou wish ko continue?
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12. Click OK when the firmware upgrade is complete.

Firmware Upgrade Wizard

The upgrade files have been downloaded to the terminal,

Check the terminal for any specific actions necessary to complete the reboot,

The terminal restarts, executing the new firmware.

Additional Resources

These documents contain additional information concerning related products from Rockwell

Automation.

Resource

Description

PanelView Plus 6 HMI Terminals User Manual,
publication 2711P-UM006

Provides information for installing, configuring, operating, and
troubleshooting PanelView Plus 6 terminals.

PanelView Plus Terminals User Manual, publication
2711P-UM001

Provides information for installing, configuring, operating, and
troubleshooting the PanelView Plus terminals.

Industrial Automation Wiring and Grounding
Guidelines, publication1770-4.1

Provides general guidelines for installing a Rockwell Automation
industrial system.

Product Certifications website,
http://www.rockwellautomation.com/
rockwellautomation/certification/overview.page

Provides declarations of conformity, certificates, and other certification
details.

You can view or download publications at http://www.rockwellautomation.com/literature/. To

order paper copies of technical documentation, contact your local Allen-Bradley distributor or

Rockwell Automation sales representative.

Allen-Bradley, FactoryTalk, PanelView, Rockwell Software, Rockwell Automation, and RSLinx are trademarks of Rockwell Automation, Inc.

Trademarks not belonging to Rockwell Automation are property of their respective companies.

Rockwell Otomasyon Ticaret A.$., Kar Plaza I Merkezi E Blok Kat:6 34752 Igerenkéy, Istanbul, Tel: +90 (216) 5698400

www.rockwellautomation.com

Power, Control and Information Solutions Headquarters

Americas: Rockwell Automation, 1201 South Second Street, Milwaukee, W1 53204-2496 USA, Tel: (1) 414.382.2000, Fax: (1) 414.382.4444
Europe/Middle East/Africa: Rockwell Automation NV, Pegasus Park, De Kleetlaan 12a, 1831 Dicgem, Belgium, Tel: (32) 2 663 0600, Fax: (32) 2 663 0640
Asia Pacific: Rockwell Automation, Level 14, Core F, Cyberport 3, 100 Cyberport Road, Hong Kong, Tel: (852) 2887 4788, Fax: (852) 2508 1846
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Introduction_Category Types

		This tab summarizes Rockwell Automation Global Sales and Marketing preferred printing standards. It also provides guidance on whether a publication should be released as JIT (print on demand) or if it requires an RFQ for offset printing.
Find your publication type in the first section below. Use the assigned Printing Category information to determine the standard print specifications for that document type. The Printing Categories are defined below the Publication Type section. Note there may be slightly different print specifications for the categories, depending on the region (EMEA or Americas).
For more information on Global Sales and Marketing Printing Standards, see publication RA-CO004 in DocMan.

		Publication Type and Print Category

		Publication Type		Off Set Print Category Spec. (See table below)		JIT Spec. (See table below)		Description		Order Min **		Order Max **		Life Cycle Usage / Release Option

		AD		NA - Puttman		NA		Advertisement Reprint Colour		NA		NA		Presale / Internal

		AP		A3		D2		Application Solution or Customer Success Story		5		100		Presale / External

		AR		NA		NA		Article/Editorial/Byline		NA		NA		Presale / Internal

								(press releases should not be checked into DocMan or printed)

		AT		B3, B4		D5		Application techniques		5		100		Presale / External

		BR		A2 Primary, A1		NA		Brochures		5		100		Presale / External

		CA		C2 Primary, C1		NA		Catalogue		1		50		Presale / External

		CG		NA		NA		Catalogue Guide		1		50		Presale / External

		CL		NA		NA		Collection		5		50		Presale / External

		CO		A5, A6, A9		D5		Company Confidential Information		NA		NA		NA / Confidential

		CP		E-only		E-only, D5		Competitive Information		5		50		NA / Confidential

		DC		E-only		E-only		Discount Schedules		NA		NA		Presale / Internal

		DI		A1, A3		NA		Direct Mail		5		100		Presale / Internal

		DM		NA		NA		Product Demo		5		50		Presale / Internal

		DS		B3		D5		Dimensions Sheet		1		5		Post / External

		DU		B3		D5		Document Update		1		5		Post / External

		GR		B2		D6		Getting Results		1		5		Post / External

		IN		B3 Primary, B2		D5, D6		Installation instructions		1		5		Post / External

		LM		NA		NA		Launch Materials		5		50		Presale / Internal

		PC		B3		D5		Packaging Contents

		PL		E-only primary, B3		E-only		Price List		5		50		Presale / Internal

		PM		B2		D6		Programming Manual		1		5		Post / External

		PP		A3		D1		Profile (Single Product or Service). NOTE: Application Solutions are to be assigned the AP pub type.		5		100		Presale / External

		QR		B2 primary, B3, B5		D5, D6		Quick Reference		1		5		Post / External

		QS		B2 primary, B3, B5		D5, D6		Quick Start		1		5		Post / External

		RM		B2		D5, D6		Reference Manual		1		5		Post / External

		RN		B3		D5		Release Notes		1		5		Post / External

		SG		B1 Primary, B4		D5, D6		Selection Guide Colour		5		50		Presale / External

		SG		B2		D5, D6		Selection Guide B/W		5		50		Presale / External

		SP		A1, A2, A3, A4		NA		Sales Promotion NOTE: Service profiles are to be assigned the PP pub type.		5		100		Presale / Internal

		SR		B2, B3		D5, D6		Specification Rating Sheet		5		100		Presale / External

		TD		B2 Primary B3, B4, B5		D5, D6		Technical Data		5		50		Presale / External

		TG		B2, B3		D6		Troubleshooting Guide		1		5		Post / External

		UM		B2 Primary, B4		D6		User Manual B/W		1		5		Post / External

		WD		B3		D5		Wiring Diagrams / Dwgs		1		5		Post / Internal

		WP		B3 Primary, B5		D5		White Paper		5		50		Presale / External

		** Minimum order quantities on all JIT items are based on the publication length. **

		Publication length		Minimum Order Quantity

		77 or more pages		1 (no shrink wrap required)

		33 to 76 pages		25

		3 to 32 pages		50

		1 or 2 pages		100

		Pre-sale / Marketing		All paper in this category is White Brightness, 90% or better. Opacity 90% or better

		Category		Color Options		AP, EMEA Paper Requirements		Canada, LA, US Paper Requirements

		A1		4 color		170 gsm  2pp		100# gloss cover, 100# gloss text

		A2		4 color		170 gsm  , folded, 4pp		100# gloss cover, 80# gloss text

		A3		4 color		Cover 170 gsm  with           Body 120 gsm, > 4pp		80# gloss cover, 80# gloss text

		A4		2 color		170gsm Silk – 120gsm Silk		80# gloss cover, 80# gloss text

		A5		2 color		170gsm Silk – 120gsm Silk		80# gloss cover, 80# matt sheet text

		A6		1 color		170gsm Silk – 120gsm Silk		80# gloss cover, 80# matt sheet text

		A7		4 color cover
2 color text
Selection Guide		Category being deleted		10 Point Cover C2S
50# matte sheet text

		A8		4 color cover		Category being deleted		50# matte sheet text, self cover

				2 color text

				Selection Guide

		A9		2 color		100gsm bond		50# matte sheet text, self cover

				Selection Guide

				Gray shading indicates Obsolete Print Catagories

		Post Sale / Technical Communication

		Category		Color Options		AP, EMEA Paper Requirements		Canada, LA, US Paper Requirements

		B1		4 color cover		270gsm Gloss 100gsm bond		10 Point Cover C2S

				2 color text				50# matte sheet text

		B2		1 color		160gsm Colortech & 100gsm Bond		90# Cover
50# matte sheet text

		B3		1 color		100gsm bond		50# matte sheet text, self cover

		B4		2 color		160gsm Colortech & 100gsm Bond		90# Cover
50# matte sheet text

		B5		2 color		100gsm bond		50# matte sheet text, self cover

		Catalogs

		Category		Color Options		AP, EMEA Paper Requirements		Canada, LA, US Paper Requirements

		C1		4 color cover		270gsm Gloss 90gsm silk		10 Point Cover C2S

				4 color text				45# Coated Sheet

		C2		4 color cover		270gsm Gloss 80gsm silk		10 Point Cover C2S

				2 color text				32#-33# Coated Sheet

		JIT / POD		All paper in this category is White Brightness, 82% or better.  Opacity 88% or better

		Category		Color Options		AP, EMEA Paper Requirements		Canada, LA, US Paper Requirements

		D1		4 color		170gsm white silk		80# gloss cover, coated 2 sides

		D2		4 color		120gsm white silk		80# gloss text, coated 2 sides, self cover

		D3		4 color		Cover 170gsm  with           Body 120gsm		80# gloss cover, 80# gloss text coated 2 sides

		D4		1 color		160gsm tab		90# index

		D5		1 color		80gsm bond		20# bond, self cover

		D6		1 color		Cover 160gsm tab with Body 80gsm bond		90# index, 20# bond

		D7		2 color		160gsm tab		90# index

		D8		2 color		80gsm bond		20# bond, self cover

		D9		2 color		Cover 160gsm tab with Body 80gsm bond		90# index, 20# bond

		D10		Combination: 4 color cover, with 2 color body		Cover 160gsm with           Body 80gsm		90# index, 20# bond

				Gray shading indicates Obsolete Print Catagories

		Just In Time (JIT) or Off Set (OS)?

		Use these guidelines to determine if your publication should be JIT (just in time/print on demand) or if it would be more economical to print OS (offset/on a press). OS print jobs require an RFQ (Request For Quote) in US. If your job fits into the “Either” category, an RFQ is recommended, but not required. In the US, RA Strategic Sourcing will discourage or reject RFQs for jobs that fall within the JIT category. Guidelines differ for black & white and color printing, so be sure to check the correct tables.

		Black & White Printing

		Color Printing

		Color Printing





Print Spec Sheet

		JIT Printing Specifications				RA-QR005J-EN-P  -  6/14/2013

		Printing Specification		YOUR DATA HERE		Instructions																																				NO

		(required) Publication Number:		2711P-IN030A-EN-P		Sample: 2030-SP001B-EN-P																														11” x 17”				LOOSE -Loose Leaf		YES		Pre-sale / Marketing				TOP

		Use Legacy Number:		NO		YES or NO																														8.5” x 11”				PERFECT - Perfect Bound				A1				LEFT

		Legacy Number if applicable:				Sample Legacy Number: 0160-5.33																														8.375” x 10.875				SADDLE - Saddle Stitch				A2				RIGHT				CORNER

		Publication Title:		LED Display Modules		Sample: ElectroGuard Selling Brief
80 character limit - must match DocMan Title																														8.25” x 11” (RA product profile std)				PLASTCOIL - Plastic Coil (Coil Bound)				A4				BOTTOM				SIDE

		Used in Manufacturing:		YES		YES or NO - If Yes, must have Part No. listed below																														8.25” x 10.875”				STAPLED1 -1 position				A3

		Part Number:		PN-213672		If SAP Part Number, be sure to enter PN- before the number																														7.385” x 9” (RSI Std)				STAPLED1B - bottom 1 position				A5

		(required) Category		B3		Select Print Category A,B,C or D from category list, on "Introduction_Category Types" tab																														6” x 4”				STAPLED2 - 2 positions				A6

		Paper Stock Color:				White is assumed.  For color options contact your vendor																														5.5” x 8.5” (half-size)				THERMAL - Thermal bound (Tape bound)				A7

		Ink Color:				One color assumes BLACK / 4 color assume CMYK / Indicate PMS number here																														4.75” x 7.75”				THERMALO - Thermal Bound (Tape bound - offline)				A8

		(required) Page Count of
Publication:		12		Total page count including cover. Enter PAGE count, not SHEET count																														4.75” x 7” (slightly smaller half-size)								A9

		(required) Finished Trim Size Width:		5.5” x 8.5” (half-size)		This is sheet size, before folding																														4.25" x 5.50"								Post Sale / Technical Communication

		Fold:		None		Review key below. Leave blank if folded for saddle stitching																														4” x 6”								B1

		Finished Fold Size:		5.5 x 8.5		This is size after folding is completed																														3” x 5”								B2

		Binding/Stitching:		LOOSE -Loose Leaf		Review key below																														9” x 12” (Folder)								B3						None

		Stitching Location:				Blank, Corner or Side																														A4 (8 ¼” x 11 ¾”) (210 x 297 mm)								B4						Half or V or Single Fold

		Drill Hole (Yes/No):		NO		All drilled publications use the 5-hole standard, 5/16 inch-size hole and a minimum of ¼ inch from the inner page border.																														A5 (5.83” x 8.26”) (148 x 210 mm)								B5						C or Tri-Fold

		Number of Tabs Needed:				5 tab in stock at RR Donnelley																														36” x 24” Poster								Catalogs						DbleParll

		Number of Pages per Pad:				Average sheets of paper. 25, 50 75,100 Max																														24” x 36” Poster								C1						Sample

		Glue Location on Pad:				Glue location on pads																														18” x 24” Poster								C2						Short (must specify dimensions between folds in Comments)

		(required) Business Group:		Marketing Commercial		As entered in DocMan																																						JIT/POD						Z or Accordian Fold

		(required) Cost Center:		19134-IA		If your Business Unit is Marketing Commercial, add the appropriate division name after 19134 using the chart on the right. 
All other Business Units: Enter only the number as in DocMan, no description. 
Example - 19021		19134 - Commerc        19134 - OEM 
19134 - Compone        19134 - Power C
19134 - Global             19134 - Process      
19134 - IA                     19134 - Service 
19134 - IMC                  19134 - Safety       
19134 - Industr             19134 - Softwar
19134 - Mkt Dig            19134 - US Marke																																				D1						Microfold or French Fold - designate no. of folds in Comments - intended for single sheet only to be put in box for manufacturing

		Comments:		I think this used to be D5 - no selection now																																								D2						Double Gate

						Folds
Half, V, Single                 C or Tri




Dble Parll




Z or Accordian                       Microfold or French





Double Gate

 


Short Fold		Saddle-Stitch Items 
All page quantities must be divisible by 4.
Note: Stitching is implied for Saddle-Stitch -
no need to specify in Stitching Location.
80 pgs max. on 20# (text and cover)
76 pgs max. on 20# (text) and 24# (cover)
72 pgs max. on 24# (text and cover)

Perfect Bound Items
940 pgs max. w/cover (90# index unless indicated otherwise)
70 pgs. min. for spine without words
200 pgs min. for spine with words 

Plastcoil Bound Items
530 pgs max. of 20# (if adding cover deduct equivalent number of pages to equal cover thickness) (90# index unless indicated otherwise)

Tape Bound Items
250 pgs max. on 20# no cover
240 pgs max. w/cover (90# index unless indicated otherwise)
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